
CML Particle Flow and Slider Contamination Program User’s Manual 

 

Xinjiang Shen and David B. Bogy 

Computer Mechanics Laboratory 

Department of Mechanical Engineering 

University of California at Berkeley 

 

1. Introduction 

 

This manual describes the first version of the CML particle flow and slider 

contamination program with its Matlab user interface, as well as its input files, 

preprocessing and post processing.  

The CML particle flow and slider contamination program requires Matlab 

installed on the computer, a commercial software from Mathworks Inc. The CML particle 

flow and slider contamination program interface integrates the preprocessing and post 

processing with two solvers: the CML air bearing solver and the CML particle flow 

solver. Both solvers are written in Fortran 77 and tested under the PC/windows 

environment. The unix/linux operating systems are currently unsupported. 

System recommendations for running the CML particle flow and slider 

contamination program: 

Hardware: 

 Intel based Pentium 4 systems above 2GHz 

    AMD based systems above AMD 2000+  
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    512Mb memory with 1Gb virtual memory 

 Software: 

Windows operating systems, Windows NT, 2000, XP. 

Matlab ver. 5.0 and above. 

CMLAir Design Program 6.5 

2. Installation 

The installation package for Windows is a zipped file named cmlparticleflow.zip. 

Unpack the file into a working directory with an unzip utility such as winzip software. As 

an example, we will assume the directory is D:\cmltemp. When you are ready to run a 

simulation, copy your input files (rail.dat, run.dat, and Particles.dat) into the working 

directory D:\cmltemp.  

 The installation does not require any association with window’s core and registry 

system. Therefore, it is very stable and robust. 

 To run the software, start Matlab from the windows start menu or desktop. Then 

change the directory in Matlab to the current working directiory, D:\cmltemp. Enter the 

command, ParticleGUI in the Matlab command window. The particle flow and slider 

contamination program interface will show up. 

 

3. Interface Guide 

The main interface is shown in Fig. 1. The menu bar includes File, Input Files, 

Slider, Preprocessing, Particle Solver, Particle Flow visualization, Results and Help. 

The File submenu includes one option only. You can save the current work and 

exit from File -> Exit. 
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To run the particle flow simulation, three input files are needed. They are 

included in the Input Files submenu as shown in Fig. 2. They are rail.dat, run.dat and 

Particles.dat. You can open and edit them in the notepad program provided by Windows 

or other commercial text editor software.  

 

In the Slider submenu, you can verify your slider design which is imported from 

CMLAir Design Program. Figure 3 shows the slider submenu. You can view the 2-D rails 

first. After you run the CML air bearing solver, you may view its 3-D profile, pressure 

profile, and the spacing map between the head and disk.  

Figure 4 shows the Preprocessing submenu. You can run the CML air bearing 

solver by clicking on “Solve Reynolds equation”. The preprocessing solver gets the 

necessary information for particle flow and slider contamination simulation, such as 

pressure and the spacing profiles where the particles will fly.  

After running the CML air bearing solver, you can now run the particle solver by 

clicking on the “Solve particle flow” button as shown in Fig. 5. To run the particle flow, 

you need to make sure that Particles.dat is in the current directory. Also, to get a realistic 

simulation, you need to specify the particle source similar to what you expect in your 

experiments. The simulation will take several hours even for a modern PC, also it may 

take a lot of computer resources such as memory and storage spaces.   

After simulating the particle flow in the head disk interface, you need to observe 

how the particles fly in your specific head disk interface design. The submenu “Particle 

Flow visualization” in Fig. 6 includes three methods of visualization. You can use the 2-

D particle flow animation to see how the particles fly in HDI from a top view. You can 
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also run the 3-D flow movie. However, this animation requires much more time and 

computer resources. The particle buildup history on the air bearing surface can also be 

visualized using the current software. 

 

The Results submenu shown in Fig. 7 lets you see the result summary of the air 

bearing slider, particle contamination profile, and the contact force and moment history 

applied to the slider by these particles. 

Figure 8 shows the Help menu. Before you run the simulation, it is recommended 

that you read the README file and this manual.  

 

4. Input Data Files 

There are three input data files in this version: rail.dat, run.dat and 

Particles.dat. The first file describes the slider geometry, while the second one 

prescribes the input parameters for the CML Airbearing Design Program. The third file 

specifies the particle properties and the environmental conditions for the particle flow 

simulation.  

 

4.1  rail.dat 

Sample rail.dat: 

CML Version 4.020  RAIL.DAT 
REPORT BUGS TO INFO@CML.ME.BERKELEY.EDU 
1.2500E-003      1.0000E-003      3.0000E-004      
 11               3                
 13               1                
1.1009E-003      4.1500E-004      2              
1.2100E-003      4.1500E-004      0              
1.2100E-003      5.8500E-004      2              
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1.1009E-003      5.8500E-004      2              
9.2772E-004      5.5000E-004      2              
9.0872E-004      5.4600E-004      2              
8.9272E-004      5.3500E-004      2              
8.8172E-004      5.1900E-004      2              
8.7772E-004      5.0000E-004      2              
8.8172E-004      4.8100E-004      2              
8.9272E-004      4.6500E-004      2              
9.0872E-004      4.5400E-004      2              
9.2772E-004      4.5000E-004      2              
3.0000E-007 
 13               1                
1.0516E-003      5.5000E-004      3              
1.0326E-003      5.4600E-004      3              
1.0166E-003      5.3500E-004      3              
1.0056E-003      5.1900E-004      3              
1.0016E-003      5.0000E-004      3              
1.0056E-003      4.8100E-004      3              
1.0166E-003      4.6500E-004      3              
1.0326E-003      4.5400E-004      3              
1.0516E-003      4.5000E-004      3              
1.2059E-003      4.1500E-004      1              
1.2500E-003      4.1500E-004      0              
1.2500E-003      5.8500E-004      1              
1.2059E-003      5.8500E-004      3              
0.0000E+000 
 13               1                
4.3915E-004      7.8000E-004      2              
3.3915E-004      6.7000E-004      2              
3.3915E-004      5.0000E-004      0              
5.0000E-005      5.0000E-004      2              
5.0000E-005      7.1500E-004      2              
5.3000E-005      7.4800E-004      2              
6.1000E-005      7.8000E-004      2              
7.4000E-005      8.1000E-004      2              
9.2000E-005      8.3800E-004      2              
2.0000E-004      9.6800E-004      2              
6.8339E-004      9.6800E-004      0              
7.0608E-004      8.4500E-004      2              
6.0000E-004      7.8000E-004      2              
3.0000E-007 
 8                1                
6.8339E-004      9.6800E-004      1              
7.6222E-004      9.6800E-004      1              
7.8122E-004      9.6400E-004      1              
7.9722E-004      9.5400E-004      1              
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8.0722E-004      9.3800E-004      1              
8.1142E-004      9.1900E-004      1              
8.1142E-004      8.7000E-004      1              
7.0608E-004      8.4500E-004      3              
0.0000E+000 
 4                1                
1.2200E-003      5.0025E-004      0              
1.2200E-003      4.9975E-004      0              
1.2199E-003      4.9975E-004      0              
1.2199E-003      5.0025E-004      0              
0.0000E+000 
 12               1                
6.8600E-004      4.9800E-004      0              
7.5100E-004      4.9800E-004      0              
7.6800E-004      5.7300E-004      0              
8.4400E-004      6.1400E-004      0              
9.8700E-004      7.3200E-004      0              
1.2500E-003      7.3200E-004      0              
1.2500E-003      9.6800E-004      0              
1.0720E-003      9.6800E-004      0              
1.0720E-003      8.6700E-004      0              
9.7300E-004      8.1900E-004      0              
7.0700E-004      6.4500E-004      0              
6.8600E-004      6.4500E-004      0              
1.0000E-005 
 13               1                
4.3915E-004      2.2000E-004      2              
3.3915E-004      3.3000E-004      2              
3.3915E-004      5.0000E-004      0              
5.0000E-005      5.0000E-004      2              
5.0000E-005      2.8500E-004      2              
5.3000E-005      2.5200E-004      2              
6.1000E-005      2.2000E-004      2              
7.4000E-005      1.9000E-004      2              
9.2000E-005      1.6200E-004      2              
2.0000E-004      3.2000E-005      2              
6.8339E-004      3.2000E-005      0              
7.0608E-004      1.5500E-004      2              
6.0000E-004      2.2000E-004      2              
3.0000E-007 
 8                1                
6.8339E-004      3.2000E-005      1              
8.6222E-004      3.2000E-005      1              
8.8122E-004      3.6000E-005      1              
8.9722E-004      4.6000E-005      1              
9.0722E-004      6.2000E-005      1              
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9.1142E-004      8.1000E-005      1              
9.1142E-004      1.3000E-004      1              
7.0608E-004      1.5500E-004      3              
0.0000E+000 
 4                1                
1.1340E-003      9.6800E-004      0              
1.1340E-003      8.6700E-004      0              
1.2500E-003      8.6700E-004      0              
1.2500E-003      9.6800E-004      0              
0.0000E+000 
 12               1                
8.0000E-005      4.2000E-004      3              
8.0000E-005      2.8500E-004      3              
8.3000E-005      2.5200E-004      3              
9.1000E-005      2.2000E-004      3              
1.0400E-004      1.9000E-004      3              
1.2200E-004      1.6200E-004      3              
2.3000E-004      5.2000E-005      1              
4.1694E-004      5.2000E-005      3              
4.1694E-004      1.6000E-004      3              
3.5915E-004      1.6000E-004      3              
2.4915E-004      3.0000E-004      3              
2.4915E-004      4.2000E-004      3              
0.0000E+000 
 12               1                
8.0000E-005      5.8000E-004      3              
8.0000E-005      7.1500E-004      3              
8.3000E-005      7.4800E-004      3              
9.1000E-005      7.8000E-004      3              
1.0400E-004      8.1000E-004      3              
1.2200E-004      8.3800E-004      3              
2.3000E-004      9.4800E-004      1              
4.1694E-004      9.4800E-004      3              
4.1694E-004      8.4000E-004      3              
3.5915E-004      8.4000E-004      3              
2.4915E-004      7.0000E-004      3              
2.4915E-004      5.8000E-004      3              
0.0000E+000 
 10 10 10 
 0.0000E+000  1.3822E-006  2.7644E-006  4.1467E-006  5.5289E-006  6.9111E-006  
8.2933E-006  9.6756E-006  1.1058E-005  1.2440E-005  
 0.0000E+000  5.2469E-007  9.8765E-007  1.3889E-006  1.7284E-006  2.0062E-006  
2.2222E-006  2.3765E-006  2.4691E-006  2.5000E-006  
 0.0000E+000  1.2222E-006  2.4444E-006  3.6667E-006  4.8889E-006  6.1111E-006  
7.3333E-006  8.5556E-006  9.7778E-006  1.1000E-005  
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 3.0000E-007  7.6173E-007  1.1691E-006  1.5222E-006  1.8210E-006  2.0654E-006  
2.2556E-006  2.3914E-006  2.4728E-006  2.5000E-006  
 0.0000E+000  1.6933E-007  3.3867E-007  5.0800E-007  6.7733E-007  8.4667E-007  
1.0160E-006  1.1853E-006  1.3547E-006  1.5240E-006  
 0.0000E+000  6.2963E-008  1.1852E-007  1.6667E-007  2.0741E-007  2.4074E-007  
2.6667E-007  2.8519E-007  2.9630E-007  3.0000E-007  
0.0000E+000      0.0000E+000      2.5000E-006      
2.5400E-008      2.5000E-009      0.0000E+000      
 1.2200E-003  1.2050E-003  2.4100E-004  2.4100E-004  
 5.0000E-004  5.0000E-004  9.7400E-004  2.6000E-005 
 

The rail structure for this sample file is shown in Fig. 9. The first two lines are the 

header. The third line contains the slider dimensions in meters: length, width, thickness. 

The fourth line indicates the number of rails and the number of (different) wall 

profiles used. Next, each rail is defined in succession. The starting line for each rail 

describes the number of points and style. A step has a style value of 1, while a ramp 

has a style value of 0. The lines that follow contain the x and y coordinates of a rail 

point and the wall profile index for the rail edge starting at that point. Note that the x 

and y coordinates are in meters instead of normalized, and the wall profile indices 

should be zero for a ramp. The final line in a rail description contains the recess height( 

or three heights for a ramp) in meters for the rail. The line that follows the rail 

definitions contains the number of wall profile points for all wall profiles. Next, each 

wall profile definition occupies two lines. The first line contains the normal distances to 

the nominal edge for the profile points. Note, the unit is in meters. A negative value 

indicates that the point is inside the nominal rail boundary, while a positive value is 

otherwise. The second line contains the recess depth in meters for each point. Note that 

the zero recess reference plane is the same as for all the rail recess depths, rather than the 

nominal recess for each rail. The next line contains the taper length in meters, the taper 
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angle in radians, and the base recess in meters. The following line gives the crown, 

camber and twist in meters. The final two lines are the x and y coordinates for the points 

of interest. 

 

4.2 run.dat 

Sample run.dat: 

CML Version 6.020  RUN.DAT 
REPORT BUGS TO INFO@CML.ME.BERKELEY.EDU 
***************Solution Control*************** 
istiff isolv   ioldg   iadpt   isave 
 1      1       0       1       1 
***************Intial Attitude*************** 
hm(m)          pitch(rad)     roll(rad) 
1.0000E-008    1.5000E-004    0.0000E+000    
***************Runs*************** 
irad           irpm           ialt 
 1             1              0              
radii(m) 
   2.3000E-002     
skews(deg) 
   9.1000E+000     
RPMs 
   7.2000E+003     
altitudes(m) 
    
***************Air Parameters*************** 
p0(pa)         al(m)          vis(nsm^-2) 
1.0135E+005    6.3500E-008    1.8060E-005    
***************Load Parameters*************** 
f0(kg)         xf0(m)         yf0(m) 
1.5000E-003    0.0000E+000    0.0000E+000    
xfs(µNM)       yfs(µNM)       emax 
0.0000E+000    0.0000E+000    1.0000E-003    
***************Grid Control*************** 
nx      ny 
 593     593 
nsx      nsy     isymm 
 1       1       0       
xnt(i), i = 2, nsx 
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nxt(i), i = 2, nsx 
  
dxr(i), i = 1, nsx 
 1  
ynt(i), i = 2, nsy 
 
nyt(i), i = 2, nsy 
  
dyr(i), i = 1, nsy 
 1  
***************Adaptive Grid*************** 
difmax         decay          ipmax 
 100            60            1       
 100            60              0        
****************Mesh refinement in x direction******* 
1 
0.380e-3    0.42e-3     0 
****************mesh refinement in y direction******* 
1 
0.325e-3    0.375e-3    0 
***************Reynolds Equation*************** 
ischeme        imdoel         akmax         beta           gamma         accommodation 
 2              3             1.0000E-007    6.0000E+000    6.0000E+000    1.0000E+000   
***************Partial Contact*************** 
icmodel        stdasp(m)      dnsasp(m^-2)   ConstantA      ConstantB 
 0             0.0000E+000    1.0000E+012    1.0000E-019    1.0000E-076    
rdsasp(m)      eyoung(pa)     yldstr(pa) 
0.0000E+000    1.0000E+010    1.0000E+012    
frcoe          pratio 
 0.3            0.3            
***************Molecular Force Hamaker Constants(ahc,bhc)***** 
0.0e-19        0.0e-76 
***************Sensitivities*************** 
crowninc(m)    camberinc(m)   twistinc(m) 
0.0000E+000    0.0000E+000    0.0000E+000    
tlnginc(m)     tanginc(rad)   loadinc(kg) 
0.0000E+000    0.0000E+000    0.0000E+000    
ptrqinc(µNM)   rtrquinc(µNM)  recessinc(m) 
0.0000E+000    0.0000E+000    0.0000E+000    
iwscale 
 1 
***************Comments*************** 
"This is a test case" 
 

Here are some explanations: 
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Solution Control: 

istiff: 1 = calculate stiffness, 0 = no stiffness calculation 

isolv: 1 = solve for fly height, 0 = given attitude 

ioldg: 1 = use existing grid data, 0 = create new grid 

iadpt: 1 = use adaptive grid, 0 = no adaptive grid 

isave: 1 = save pressure and mass flow, 0 = don't save 

Initial Attitude: 

hm(m): nominal trailing edge height 

pitch(rad): pitch, note the change in units from the previous version 

roll(rad): roll 

Runs: 

irad: number of disk radii where the solution is sought 

irpm: number of RPMs 

ialt: number of altitudes, 0 = use Air Parameters 

radii(m): disk radii 

skews(deg): skews corresponding to each disk radii 

rpms: RPMs 

altitudes(m): altitudes, lowest one is the base case. 

Air Parameters: 

p0(pa): ambient pressure 

17 

al(m): mean free path 

vis(NS/M2): viscosity 

Load Parameters: 
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f0(kg): load 

xf0(m): load point x offset, origin is at the geometric center now! 

yf0(m): load point y offset 

xfs(µΝΜ): static pitch torque, note the change of unit 

yfs(µΝΜ): static roll torque 

emax: convergence criterion of load error 

Grid Control: 

nx: total x grid number (16k+1) 

ny: total y grid number (16k+1) 

nsx: number of sections in length 

nsy: number of sections in width 

isymm: 1 = symmetry in width, 0 = specify entire width 

xnt(i), i = 2, nsx: x control points in meters, no longer normalized! 

nxt(i), i = 2, nsx: grid indices at x control points 

dxr(i), i = 1, nsx: grid ratios for each x section 

ynt(i), i = 2, nsy: y control points, use half width if isymm = 1 

nyt(i), i = 2, nsy: grid indices at y control points 

dyr(i), i = 1, nsy: grid ratios for each y section 

Adaptive Grid: 

difmax: ratio of max/min gradient allowed 

decay: smaller value increases smoothness 

ipmax:1 = use maximum gradient, 0 = average gradient 
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The adaptive grids in the x and y directions are controlled separately by two lines. 

The first line specifies difmax, decay and ipmax for the x direction. The second line 

defines these parameters for the y direction. 

Mesh refinement in x and y directions: 

The first line defines how many locations will be refined by the end user. The following 

lines specify the starting and ending locations for mesh refinement. 

Reynolds Equation: 

ischeme: convective term scheme.  

0 = upwind 

1 = hybrid 

2 = power-law; default 

imodel: slip model 

1 = first order slip 

2 = second order slip 

3 = FK; default 

akmax: convergence criterion for the Reynolds equation 

Partial Contact: 

icmodel: 0 = no contact model 

1 = Greenwood-Williamson 

2 = Elastic-Plastic 

stdasp(m): standard deviation of asperity height 

dnsasp(m-2): asperity density 

rdsasp(m): mean radius of curvature of asperity 
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eyoung(pa): Young's modulus 

yldstr(pa): yield strength 

frcoe: friction coefficient 

pratio: Poisson's ratio 

Intermolecular Force menu 

Two constants, ahc and bhc, are defined for the adhesive force between the head and 

disk for ultra low flying height sliders. The first one is the effective Hamaker constant 

between the slider and disk. The second is the constant B used in the Lernard Jones 

potential. For detailed information of these two parameters, please refer to Lin Wu’s Ph. 

D. dissertation at CML, “Physical Modeling and Numerical Simulations of the Slider Air 

Bearing Problem of Hard Disk Drives”. 

Sensitivities: 

Zero increment means no sensitivity is calculated for the parameter. 

crowninc(m): crown increment 

camberinc(m): camber increment 

twistinc(m): twist increment 

tlnginc(m): taper length increment 

tanginc(rad): taper angle increment 

loadinc(kg): load increment 

ptrqinc(µΝΜ): pitch torque increment 

rtrqinc(µΝΜ): roll torque increment 

recessinc(m): recess increment 

iwscale: used with recessinc 
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0 = stretch the profile, the normal distances are unchanged, 

only the depths are scaled. 

1 = scale the wall profile with recess. For the part of the 

profile that is outside the nominal rail boundary, the normal 

distances will change proportionally with recess. 

4.3 Particles.dat 

Sample Particles.dat 

lamda      rous      roup       amu          p0 
.635e-7  1.4128d0   3.52d3   1.488e-5   1.0135e+5 
NX|NY|NZ| 
1   50  10 
Xmean Std 
200e-09 50e-9  
  xp0      yp0       zp0            
 0.02       0.04         6.0 
 0.02       0.75        25.0 
The velocity ratio to the disk |particle velocity option 
7.5 2 
 Time for simulation (T, DT)  
5.0  1e-3 
|The skew angle of the slider| Particle Module|Particle Distribution Option| 
-17.55 2 2 
|Gravity Effect| Saffman Lift|Magnus Lift | Pressure Gradient|Vortex 
0.0 1.0 1.0 1.0 1.0 
|Particle|Airbearing Module|Layer Streamline Module| 
1 0 0 
|Particle Nature:1: Soft; 2: Hard| 
2 
|Mechanical and Thermal Properties of particle(TiC)| 
Young's Modulus|Poison's Raio|Hardness|Thermal conductivity|SPecific Heat| 
4.39d11    0.187          2.47d9              30.9                710.6 
Disk Material Properties(Aluminum)  
|Density|Modulus|Poison's Ratio|Hardness|Thermal Conductivity|Specfific Heat(J/kg.C)| 
2.7d3      6.9d10      0.3269      1.20d8            166.9          896 
Slider Material Properties(TiC 40% Al2O3 60%) 
|Density|Modulus|Poison's Ratio|Hardness|Thermal Conductivity|Specfific Heat| 
4.31d3     4.390d11      0.2          2.42e9              27.0          898  
Friction Coefficient( Betweeen particle and slider) 
0.2 
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lamda: free mean path of the air. 

rous: air density 

roup: particle density 

amu: air viscosity. 

p0: air ambient pressure. 

NX,NY,NZ: Number of particles in the X, Y, Z directions. 

Xmean, Std (m): these two parameters define the particle mean size and standard 

deviation for a Gaussian distribution. 

xp0, yp0, zp0: define the initial location of the particles. The first line defines the lowest 

value of x, y, z. The second line defines the upper limit of x, y, z. 

The velocity ratio of particle to the disk is used for the initial particle velocity 

option. Particle velocity option: 1: its ratio to the disk velocity is specified. 2: air borne 

particles. 2 is the default option for most cases. 

T, DT: simulation time and time step. These two are normalized. The user can change the 

time step to balance the calculation time and accuracy based on experience. 

In the remaining part of the input file, each item is clearly defined. The user can 

enter the corresponding value for specific case. 

 

5. Output data files 

 The output files include ParticleD.dat, Pcontaminates.dat, Summary.dat, and 

Contacts.dat. These output files are post processed in the particle flow and slider 

contamination software interface.  
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6. Post processing 

 The post processing for particle flow and slider contamination includes 

visualization of the particle flow in the head disk interface, the final particle 

contamination profile on the slider, and the contact force and moment history acting on 

the air bearing slider. They are integrated into the software interface. Advanced users 

may modify the corresponding module to get other information. For visualization post 

processing, a movie file is generated for each animation. They are found in your working 

directory after you run the animation. 
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Figure 1. Matlab Interface 

 

Figure 2. Input Files 

 18



 

Figure 3. Slider Information 

 

 

Figure 4. CML Air Bearing Solver 
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Figure 5. CML Particle Flow and Slider Contamination Solver 

 

Figure 6. Particle Flow Visualization Modules 
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Figure 7. Particle Result Files 

 

 

Figure 8. User’s Manual and README Files 
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Figure 9. A sample air bearing slider. 

 22


